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Taman insinddritydn tarkoituksena oli tuottaa ohje pistepilviaineiston vektorointiin ja pinta-
mallin tekemiseen kayttaen Microstation- ja Terra-ohjelmistoja. Ohjeen on tarkoitus toimia
opetusmateriaalina henkiloston koulutuksessa, seka tukena koulutuksen jalkeisessa vekto-
rointi tydssa.

Ennen ohjeen laatimista opettelin vektorointi prosessia kahden Staran Projektimittauksen
kantahenkilékunnan jasenen opastamana. Tata varten sain Projektimittaukselta kannetta-
van tydaseman seka pistepilviaineiston, jotka olivat kaytdssani koko kirjoitustydn ajan. Oh-
jeen laatiminen tapahtui padasiassa itsenaisesti, mutta ongelmatilanteiden ja kysymysten
iimetessa sain konsultointiapua puhelimitse, taikka kasvotusten Projektimittauksen toimis-
tolla. Ohje oli valmis, kun molemmat osapuolet olivat tyytyvaisia sen sisaltoon.

Vektoroitaessa pistepilvi jaetaan aluksi kasiteltdvan kokoisiin osiin. Taman jalkeen ylimaa-
raiset ja virheelliset pisteet poistetaan ja siivottu aineisto luokitellaan. Luokittelu helpottaa
kasittelya ja on pakollinen pintamallin muodostuksessa. Luokittelun jalkeen aineisto vekto-
roidaan ja vektorit muutetaan kartoituskohteiksi. Lopuksi luodaan pintamalli vektori- ja pis-
tepilviaineiston pohjalta. Prosessin tuloksena syntynyt kartoituskuva vastaa takymetrilla tai
GNSS-vastaanottimella tuotettua kartoituskuvaa ja soveltuu siten hyvin kartoitetun alueen
suunnittelun pohjaksi.

Lopputuloksena syntyi ohje, jota Microstation ohjelmiston kayttéén perehtynyt henkild voi
seurata ja oppia samalla vektorointi prosessiin liittyvat tydkalut ja tydvaiheet.

Avainsanat pistepilvi, vektorointi, Microstation, Terra, pintamalli
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Abstract

Author Ville Heikkinen
Title Point Cloud Vectorization with Microstation and Terra software
Number of Pages 17 pages + 1 appendix
Date 27 April 2021
Degree Bachelor of Engineering
Professional Major Land Surveying
Instructors Jussi Laari, Senior Lecturer
Eero Kannosto, Service Manager

The purpose of this final year project was to produce a manual for point cloud data vecto-
rization and surface modelling in Microstation and Terra software. The manual was intended
to serve as teaching material in staff training, as well as to support post-training vectoriza-
tion.

Portable workstation and point cloud material were used to practise the vectorisation pro-
cess, which began with dividing the point cloud into parts of reasonable size, removing ex-
cess and erroneous points and classifying the material. The process continued with vecto-
rization, and converting the vectors into objects. Finally, a surface model was created on the
basis of the vector and point cloud data. When problems or questions arose in the process,
employees of the company were consulted in order to solve them. Once all parties were
satisfied with the contents of the manual, it was considered complete.

The result of the final year project was a manual that a person who is familiar with the use
of Microstation can follow and, at the same time, learn the tools and work steps related to
the vectorization process.

Keywords point cloud, vectorization, Microstation, Terra, surface model
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Lyhenteet

CAD Computer-aided design. Tietokoneavusteinen suunnittelu.

UAV Unmanned aerial vehicle. Miehittdmaton ilma-alus.

GNSS Global navigation satellite system. Globaali satelliitti paikannus jarjestelma.
3D Three dimensional. Kolmiulotteinen.

VRS Virtual reference station. Virtuaalinen referenssiasema.
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1 Johdanto

Mobiililaserkeilaaminen mahdollistaa suurien alueiden kartoittamisen yhdella kertaa.
Keilauksen tuotoksena syntyvat pistepilvet tulee kasitella ja vektoroida. Ne kelpaavat
sellaisenaan vain visuaaliseen tarkasteluun ja tiedostojen suuri koko tekee niista raskaita
kasitelld. Vektoroimalla pistepilviaineistosta tuotetaan kartoituskuva, joka vastaa taky-

metrilla tai GNSS-jarjestelmalla suoritettua kartoitusta.

Ty6 tehtiin Helsingin kaupungin liikelaitos Staran kaupunkitekniikan rakentamisen osas-
ton projektimittaus yksikélle. Staran projektimittaus yksikdn kayttéén on kesan 2019 ai-
kana tullut mobiililaserkeilain. Projektimittauksen yhdeksasta kantahenkilékunnan jase-

nesta vain kahdella on koulutus Pistepilvien kasittelyyn ja vektorointiin.

Tama insindorityd on laadittu toimimaan ohjeena projektimittauksen kartoittajille, joilla ei
ole aiempaa kokemusta pistepilviaineiston vektoroinnista. Tyon tavoite on tuottaa mah-

dollisimman suuri hy6ty projektimittaukselle ja muille Staran yksikdille.

Teoriaosuudessa kaydaan lapi kaytetyt ohjelmistot ja niiden roolit. Lisaksi siind valote-
taan ohjeen suunnitteluratkaisuita ja kdydaan lapi kirjoitus prosessia. Oppaassa kaydaan
lapi pistepilviaineiston siivoaminen ja jakaminen kasiteltaviin osiin, pisteiden luokittele-

minen, vektorointi ja pintamallinnus.
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2 Tyon tilaaja

Tyon tilaaja on Helsingin kaupungin Staran kaupunkitekniikan rakentamisen osaston

projektimittaus yksikkd. Stara on Helsingin kaupungin rakentamispalvelu, joka rakentaa

ja hoitaa katuja ja puistoja, korjaa rakennuksia, hoitaa luonnonmukaisia alueita ja tarjoaa

logistiikan ja teknisen alan asiantuntijapalveluita. [1; 2.]

Staran mittausyksik6t kuuluvat kaupunkitekniikan rakentamiseen (kuva 1). Projektimit-

taus on yksi neljasta mittausyksikdsta. Sen tehtavat ovat muita mittausyksikoita laajem-

pia ja keskittyvat katualueiden sijasta puistojen, yleisten alueiden ja kaupungin kiinteis-

tdjen kartoittamiseen ja merkintdan. Lisaksi projektimittaus tarjoaa erikoismittauksia ku-

ten UAV-ilmakuvausta, seka staattista ja mobiilia laserkeilausta. [1; 2.]
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Projektimittauksen toimipiste sijaitsee Hammarskjoldintielld olympiastadionia vasta-
paata. Samassa sijainnissa toimii myos Staran kukkamyynti ja talvipuutarha. Projektimit-

tauksessa on yhdeksan vakituista tydntekijaa ja lisaksi kesaisin kaksi harjoittelijaa. [2]

Stara tyollistaa yhteensa noin 1 400 tyontekijaa ja kesaisin tyontekijéiden maara on lahes
kaksi tuhatta.

Staran liikevaihto vuonna 2019 oli 250,2 miljoonaa euroa. Liikeylijdgdmaa kertyi 7,7 mil-

joonaa ja tilikauden ylijadmaksi muodostui 5,7 miljoonaa. [4]

3 Vektorointi

3.1 Vektorimuotoinen paikkatieto

Vektoroitu kartoituskuva muodostuu pisteista, joista voidaan myds muodostaa viivoja tai
polygoneja. Jokaisella pisteellda on koordinaatit ja ominaisuustietoja, joiden avulla kartoi-
tuskohdetta kuvataan. Tasta syysta vektori pohjaisia kuvia pystytdan muokkaamaan hel-

pommin. Niiden tarkkuus ei rajoitu resoluutioon, joten kuvan teravyys sailyy zoomatessa.

Vektoripohjainen kartoituskuva ei ole kuva vaan taulukko, jonka kartoitusohjelma piirtada
kuvaksi. Tama tekee vektoripohjaisista tiedostoista kooltaan pienia ja kevyita kasitella.
Lisaksi niiden pohjalta on helppoa ja nopeaa tehda esimerkiksi pinta-alalaskelmia taikka

etsid kohteita niiden ominaisuustietojen perusteella. [5]

3.2 Vektoroinnin hyddyt

Mobiililaserkeilaus on monesta syysta perinteisia kartoitus metodeja parempi vaihtoehto.
Syyt ovat kaytanndllisia ja taloudellisia. Erityisesti suurilla tydmailla ja katualueilla mobii-
lilaserkeilaus on nopeampi, kustannustehokkaampi ja turvallisempi vaihtoehto. Mittauk-
sen tarkkuus on nykyisella kalustolla vastaava tai paikoittain jopa parempi. Mobiililaser-
keilaus ei myodskaan vaadi tdydennysmittauksia, koska laserkeilauksessa syntynyt pis-
tepilviaineisto ei rajoitu yksittaisiin kartoituskohteisiin, vaan kattaa koko kartoitettavan

alueen.
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Pistepilviaineisto ei kuitenkaan ole riittava sellaisenaan vaan se vaatii myds vektoroinnin.
Valmis kartoitus menee usein konsultille, joka suunnittelee aluetta kartoituksen pohjalta.
Pistepilviaineisto on kooltaan suuri, ja sen kasittely vaatii tehokkaan tydaseman ja ohjel-
mistoja, joiden arvokkaita lisensseja konsulteilta harvoin 16ytyy. Konsulteilla ei my6skaan
usein ole asiantuntemusta pistepilvien kasittelyyn, ja vektoroitu kuva on heille havainnol-

lisempi. [6]

4 Kaytetyt ohjelmistot

Projektimittaus kayttaa kartoituksien kasittelyyn Microstation- ja Terra-ohjelmistoja. Huo-
mioitavaa on, etta tassa luvussa kaydaan lapi vain naiden ohjelmistojen roolit vektorointi

prosessissa.

4.1 Microstation

Microstation on Bentley Systemsin kehittdma CAD-ohjelmisto kaksi- ja kolmiulotteisen
vektorigrafiikan piirtdmiseen. Se on alansa johtava ohjelmisto ja on laajassa kaytdssa
maailmanlaajuisesti. Helsingin kaupungin rakennusvirasto ja Staran mittausyksikot kayt-

tavat Microstation-ohjelmistoa kartoituksien kasittelyyn ja piirtdmiseen. [7]

4.2 Terrasolid-laajennukset

Terrasolid on suomalainen ohjelmistokehittdja. Suurin osa sen ohjelmistoista on tehty
laajennuksiksi Microstationiin. Terrasolid-laajennukset ovat tarkea osa kartoituksen piir-

toprosessia ja ne ovat laajassa kaytdssa maanmittausalalla. [8]
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421 Scan

TerraScan-sovelluksessa on tyokalut pistepilvien hallintaan ja prosessointiin. Sen avulla
pistepilvi jaetaan kasiteltdvan kokoisiin palasiin ja siivotaan ylimaaraisista ja virheellisista
pisteista. Pisteet luokitellaan niiden ominaisuuksien mukaan esimerkiksi maanpinnaksi

ja kasvustoksi (kuva 2). Tama helpottaa vektorointia ja pintamallin muodostusta. [9]

Bt 2] B S el @ 0 @ G B

Kuva 2. Pistepilven hallintaa TerraScan-ohjelmistolla. Pistepilvi on luokiteltu ja jokaisella luokalla
on oma varikoodinsa [9].

4.2.2 Modeler

TerraModeleria kaytetaan pintamallien tekemiseen ja korkeuskayrien piirtdmiseen. Pin-
tamallin muodostuksessa voidaan kayttaa yhta taikka useampaa lahdetta. Ohjeessa pin-
tamalli tehdaan kayttden vektoroituja kartoituskohteita seka TerraScanilla luokiteltuja
maanpinnan avainpisteitd. Valmiista pintamallista (kuva 3) voidaan piirtdad korkeus-
kayrat, jotka tulevat lopulliseen kartoituskuvaan. [10]
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Kuva 3. Kolmioidun pintamallin karsintaa TerraModelerilla. Kuvassa keltaisella nakyvat kolmiot
on karsittu pois, eivatka siten ole mukana korkeuskayrien muodostuksessa.

4.2.3 Survey

TerraSurveyn avulla takymetreilld ja GNSS-vastaanottimilla tuotettu tekstipohjainen mit-
tausdata muutetaan kolmiulotteiseksi kartoituskuvaksi. Laserkeilatessa kartoitettavia
kohteita ei erotella, vaan tuloksena on pistepilvi, jonka kohteet yksiléidaan muodosta-

malla kartoituskohteista vektoreita.

Surveylla pistepilvesta vektoroiduille kohteille annetaan kartoituskoodit, joilla on ennalta
maaratyt piitosdanndét (kuva 4). Nain pistepilvesta tuotetaan kartoituskuva, joka vastaa

takymetrilla tai GNSS-vastaanottimella tehtya kartoitusta. [11]

{4 Draw As Feature - by
fipod} | ER
Koodi: |30 Pylvas -

Numers: | 19
Mitta: | 300 mm

Piirrs koodina

[ Luo kepie

Kuva 4. Vektoreiden muuntamista kartoituskohteeksi TerraSurveylla.
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5 Maastotyot ja georeferointi

Ohje alkaa pistepilvien tuonnista Microstation-sovellukseen. Tatd ennen on suoritettu

maastotyot, seka pistepilven siivous ja georeferointi.

5.1 Maastotyot

Pistepilviaineisto on tuotettu mobiililaserkeilaamalla. Keilauksessa on kaytetty Riegl
VMX-1HA-mobiililaserkeilainta (kuva 5), joka on kalibroitu yhteen inertiamittalaitteen
kanssa. Inertiamittalaite mittaa ajoneuvon ja keilaimen kallistumia kolmella eri akselilla.
Lisaksi autossa on kiihtyvyys mittari. Naiden avulla keilaimen sijaintia paivitetaan reaali-
aikaisesti sisaisen ja ulkoisen tarkkuuden takaamiseksi. Mittalaitteet on asennettu BMW
X5-katumaasturiin, jolla kartoitusalue on ajettu lapi useaan kertaan pistepilven tiheyden
varmistamiseksi. Mittausalueella on ollut myds Sokkian GCX2-mallinen kiinted GNSS-
tukiasema. [6; 12.]

Kuva 5. Riegl VMX-1HA-mobiililaserkeilain [13].

5.2 Siivous ja georeferointi

Kiintedn tukiaseman tarkkuutta parannetaan virtuaalisilla tukiasemilla. Virtuaaliset
GNSS-tukiasematiedot haetaan Trimnetista, joka on Geotrim nimisen yrityksen luoma ja
yllapitdma tukiasemaverkko. VRS-teknologia mahdollistaa virtuaalitukiasemien luomi-
sen, joiden avulla saadaan virhekorjattu korjausviesti GNSS-havainnoille (kuva 6). Kor-

jauslaskenta suoritetaan jalkikateen Topcon Tools8 -sovelluksella. [12; 14.]

y

@mpolia



virtual Reference Swtion
[VRS] correction

Physical Reference Station
correction

Kuva 6. Virtuaalitukiaseman toiminta [15, s. 4].

Virhekorjatut tukiasematiedot seka inertia- ja kiihtyvyysanturien tiedot tuodaan seuraa-
vaksi Pospac-ohjelmistoon, jonka avulla antureiden tiedot saadaan georeferoitua. Geo-

referoinnilla tarkoitetaan havaintojen sitomista koordinaatistoon.

Mobiililaserkeilaimen tuottamat pistepilvet ja georeferoidut anturihavainnot tuodaan ta-
man jalkeen RIPROCESS-ohjelmistoon. Tassa vaiheessa pistepilvi sidotaan koordinaa-
tistoon ja pistepilvelle suoritetaan suuripiirteinen siivous, jossa mitta-alueen ulkopuolella
olevat pisteet, seka heijastumat poistetaan (kuva 7). Lopuksi pistepilvi voidaan kirjoittaa

ulos Microstation-ohjelmiston tukemassa LAZ 1.2-formaatissa. [12; 16.]
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RIPROCESS f[------=-=-=====»=====-= :
Laser Scanner Raw Data I Posifion and Adi PS base
] {full wavetom scan data ! fude giation]
' Laser Scanner Raw Dala files, .scff] . INS/GNSS raw data raw data
! (discrete scan data fils, * !
., .20d. mp) ]
RIANALYZE 1
: Full Woveform Analysisand W leiTh )
I ! saftware
' SDCImport ‘ : i
1 1
. ' . '
1 Laser Scan Data i
] DI G EIED in the scanner's own ' = Position wl:gmw%%EF
] coordinate system [.sdc ' jectory
' : & sl . coordinate reference systern
] L I
1 1
' by
1 [}
1 Calibration o “mmn [
] [}
| information Cu'nwﬂb' data |
1 i data coordinate transformation
' . i
: ! L i
' H 1
' Data Visualization & Laser Scan Data
' scan Data Adjustment === |nvarous coordinate : legend:
: referance systems ! : Dess seeqvect o o e
i L generoted by RIEGL b thincd oty
""""""""""""" t""" - hand- or softwares hard- ar softwarne
Peint Cloud manipulation: FEGL Thirg porty
DTM, D5M, Classification, software modules e VT
CAD-modelling, ...
1) usirg GecSysMaragess e —= assential workflow - — = opfional workdow

Kuva 7. RiPROCESS-ohjelmiston tyonkulku [16].

6 Ohje

Insin6oritydn tydosuus on ohje pistepilvi aineiston vektorointiin ja pintamallin tekemiseen

Microstation- ja Terra-ohjelmistoilla.
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6.1 Sisaltd

Ohjeen sisdltd seuraa vektoroinnin prosessin vaiheita kronologisessa jarjestyksessa
(kuva 8). Jokainen tyOvaihe on selitetty ja havainnollistettu kuvilla. Lisaksi tyovaiheisiin

tarvittavat tyokalut ja niiden I0ytaminen valikoista on tuotu esille.

Sisallys
1 Pistepilvien tuonti 1
2 Blockien muodostaminen ja numerointi 2
3 Luokittelu ja macrot 7
4 Viivamaiset kohteet 15
41 Kanttikivet 19
411 Temascanin tydkalu kanttikiven havainnoimiseen 20
5 Pistemaiset kohteet 21
6 Pintamallin teko 23
6.1 Model keypoints 23
6.2 Pintamallin teko modelkeypointseista 25
6.3 korkeuskdyrien piirtdminen 27

Kuva 8. Ohjeen siséllysluettelo.
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6.1.1 Pistepilvien tuonti, blokkijako ja luokittelu

Ohje alkaa LAZ 1.2-muotoisten pistepilvien tuonnista Microstation-ohjelmistoon (kuva 9).
Pistepilviaineistot ovat niin suuria ja raskaita etta ne taytyy jakaa kasiteltavan kokoisiin
osiin, joita kutsutaan blokeiksi. Taman jalkeen pisteet luokitellaan niiden ominaisuuksien

mukaan kasittelyn helpottamiseksi. Luokkia ovat mm. maanpinta, matala kasvillisuus,
korkea kasvillisuus ja roskat.

Format: | LAS 12 x
Flename: hemarmirrantatissapor - sca
Poirts: 1100 802 568

BETHI24

Cefire
25458766 -

T oz Fistepilvet tuodaan Microstationiin Terrascanin
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[ Oy every | 100 th point

[] Onby dass 2 - Ground -

Valitaan File -= Read points -= Valitaan pistepil-
B intensity Hon

5 tre ] Scamer vet ja kaytetaan kuvan mukaisia asetuksia.
9 Echo & gl
Load Points -ikkunan yldosassa ndkyy tuotavien
& T,r._. : '.f::_ pisteiden madra. Pisteiden harvennus maante-
aa: Al it ) : _ .
tddn siten ettd ladattuja pisteitd on maksimis-
Line rurmbers: | Liss from fie -
saan 40 000 000.
Scanner numben: | Use from file bl
Cance

Kuva 9. Pistepilvien tuonti TerraScan-ohjelmistoon.

6.1.2 Vektorointi

Kun luokittelu on saatu suoritettua ja ylimaaraiset seka virheelliset pisteet on siirretty
roskat tasolle, alkaa viivamaisten ja pistemaisten kohteiden vektorointi. Vektoroitaessa

kartoitettavat kohteet piirretdan pistepilviaineistoa apuna kayttden. Oikeiden

-
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12

tartuntalukkojen (kuva 10) ja visuaalisten tydkalujen (kuva 11) kaytté ovat tassa vai-
heessa oleellisessa asemassa. Kun kaikki kohteet on piirretty, ne muutetaan TerraSur-
veylla kartoituskohteiksi. Kartoituskohteilla on omat piirtosaannét ja mahdollisia ominais-

tietoja, kuten esimerkiksi puulla halkaisija.

L Mouse ... — >

Adjust elevation Dz: | 0.00
Adjust xy

Paint: [Closest -
Within: | 5.00 m

Kuva 10. Tartunta pistepilveen.

Fiilottamalla High vegeta-
tion —luokan, kanttikiven

nakee paremmin.

Kuva 11. Display mode -tyokalun kayttda.
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6.1.3 Pintamalli ja korkeuskayrat

13

Lopuksi pistepilviaineistosta tehdaan pintamalli (kuva 12). Pintamallin tekemiseen kay-

tetdan vektoroituja taiteviivoja ja kartoituskohteita seka pistepilvesta luokiteltuja avain-

pisteitd. Kolmiointia tarkastellaan varjostuksen avulla ja virheellisia pisteita ja kolmioita

karsitaan siten etta pintamalli vastaa todellista maastoa paremmin. Korkeuskayrat piir-

retdan kolmioinnin pohjalta kolmioinnin korjaamisen jalkeen.
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66758136.925 +3.236 21258
6675814316 +2.524 638
v
Idertify

Create surface model

Point class: |E - Model keypoints

=|

QK Cancel

Kolmigi pinta

Kars ukoreunat: | Dletuskarsinta

Piamei kuir
F] Karsi kaikki pitkat kolmiot
Pemgi kuin: | 50.0
[[] Harvenna Lahekk siset pistest
[ Monista pistetta tatevivaan

[] Suodata vithepisteet

Fiira tasola: |5

o]

Pinnan tiedot
Yieistiedot
Tyyppi: | Maa

Talletus

Tiedosto:  her ammomramtatoeblock 3107

[}

Pennta

Peruuta

Kuva 12. Pintamallin luonti Model keypointseista.
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6.2 Ohjeentekoprosessi

Ohjeentekoprosessi alkoi 11.10.2019 aloituspalaverilla, jossa sovimme ohjeen tilaajan

kanssa tyon sisallosta.

Alkupalaverin jalkeen projektimittauksen kaksi vektorointia tekevaa kantahenkilokunnan
jasenta opettivat minulle vektorointiprosessia. Opetustilanteista laadittiin yksityiskohtai-
set muistiinpanot, joita kaytettiin pohjana ohjeen tekemisessa. ltsendinen opettelu tapah-
tui projektimittauksen kannettavalla tydbasemalla, jolla kasittelin Hermannin rantatien mo-
biililaserkeilausaineiston. Samat kantahenkildkunnan jasenet vastasivat ohjetta teh-

dessa heranneisiin kysymyksiin ja avustivat ongelmien ilmetessa.

Nama aiemmin vektorointia tehneet kantahenkildokunnan jasenet tarkastivat ohjeen ja
antoivat korjaus- ja parannusehdotuksia. Ehdotettujen korjausten jalkeen he arvioivat
ohjetta uudelleen. Tama prosessi toistui, kunnes osapuolet olivat tyytyvaisia ohjeen si-

saltoon.

6.3 Ohjeen hyddyt

Monet projektimittauksen kartoituksista sijoittuvat tydmaa- ja katualueille. Naissa koh-
teissa tyoskentely on usein hidasta ja vaarallista. Mobiililaserkeilaimella suurienkin alu-
eiden maastotyot voidaan tehda yhdella kertaa esimerkiksi yolla, jolloin likenteen maara

on vahaista.

Talvisin lumi ja jaa tekevat pintojen ja materiaalirajojen kartoittamisesta vaikeaa. Lisaksi
oikeiden maanpinnan korkouksien mittaamiseksi kartoittajan on kaivettava maanpinta
nakyviin. Pintamallia tehdessa korkeuspisteitad tarvitaan usein satoja, jolloin suuri osa
kartoitukseen kaytetysta ajasta menee lumen siirtelyyn. Kartoittajalta saattaa jaada myos
huomaamatta lumen peittdmia materiaalirajoja. Takymetrimittauksessa kolmijalan pai-
kallaan pysyminen on varmistettava. Kojeasemaa ei siis voi tehda lumelle tai jaalle,
koska sulaessaan ne aiheuttavat orientoinnin ja tasauksen menetyksen. Mobiililaserkei-

laamalla maastoty6t voidaan tehda nopeasti maan viela ollessa sulana. [17, s. 25.]

s
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Vektoroinnin ajankohta voidaan valita joustavammin, koska se ei ole riippuvainen ulkoi-
sista tekijoista tai olosuhteista. Tama tuo joustoa kartoituksien suunnitteluun ja toteutuk-
seen. Toita pystytaan myds jakamaan tasaisemmin kausille, joina tilauksia on vahem-
man tai olosuhteet tekevat maastotdista hankalaa.

Projektimittauksen kartoittajat voivat seurata ohjetta askel askeleelta ja oppia samalla
prosessin eri vaiheet ja tarvittavat tyokalut. Taten heidan kouluttamisensa tehtavaan no-
peutuu ja koulutukseen vaadittavien resurssien tarve pienenee. Ongelmatilanteiden il-
metessa kartoittaja voi palata ohjeeseen ja tarkistaa oikean tavan tydvaiheen tekemi-

seen.

y =
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Johdanto

Tama ohje on laadittu Staran Projektimittaukselle osana insindority6ta. Ohje on suun-

nattu projektimittauksen kartoittajille, jotka eivat ole aiemmin tehneet vektorointia piste-
pilvi aineistosta.

Tyo tapahtuu Microstation—ohjelmistolla ja sen TerraScan, -Survey ja -Modeler lagjen-
nuksilla.
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1 Pistepilvien tuonti

Define Coordinate Setup

Liruts and resolution
m

B | perm

Aluksi projektille maaritetdan reso-

Origin . 3
Epsting:  26495185.000 luutioksi 4000 per m.
Morthing: 6675370000
Eeevation. 0.000
Coordinate range
Esstings: +34558314 . <26033056
Marthings:  +5138433 T2
Blevabons:  -536871 +5368T1
Carncel
Fomat:  LAS 1.2 .
Rlename.  hamarnirranilisapor - scal
Parts: 1100 502 568
6675224
: Defre 2 2 3 s =
2498766 Pistepilvet tuodaan Microstationiin Terrascanin
Trarafom: | None =
R view: [1 padikkunasta.
A Gl every | 100 th pairé
[ Oy glase 2 -Geound -
ey Valitaan File -» Read points -»> Valitaan pistepil-
] interusty Hon e e i o :
5 Scanner vet ja kdytetddn kuvan mukaisia asetuksia.

Aol
Mo

Load Points -ikkunan yldosassa nakyy tuctavien

i me il pisteiden maara. Pisteiden harvennus maarite-
ki i : s Fer
tdaan siten ettd ladaftuja pisteita on maksimis-
L rumbers: | Lise from file -
saan 40 000 000.
Scanrer rumbon:  Lise from fle »
Cance

STARA
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2 Blockien muodostaminen ja numerointi
Pistepilven koon vuoksi se tulee jakaa osiin, joita kutsutaan blockeiksi. Blockirajojen teko

tapahtuu Smartline-tydkalulla. Pistepilvi jaetaan kasittelyn kannalta jarkevasti ja siten,

ettd jokaiseen blockiin tulee 10 - 40 miljoonaa pistetta. Blockirajoja pirtaessa elementti

tulee sulkea, jotta pisteitd ei jaa blockien ulkopuolelle.

Hyvin tehty blockijako.

Aluksi fontin koko muutetaan suuremmaksi, jotta blockeissa olevien pisteiden maara na-

kyy paremmin.

] AL [ * A i
|A L A Al v C- AL at At
LoAA N M Meretelma  [Kobdisiuspste ]
< 4 3 B2 I el
A 3 Tekattyyi: | Tyl fyhia) X
e ]
2 T * 7 e = Alctiriiodma: | 0.0 &
- g — — Korkeus
o st 2 ' Leveys
il g ol [A Tee mutokaet kaikin tekstehin
Purustustuotanto L
Tilavuusmalinnus L4

STARA
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Aloitetaan piirtdamalla ensin yksi blocki ja kokeillaan sen jélkeen Design Block Boundaries

-tyGkalulla montako pistetta blockiin tuli. OK-napin painamisen jalkeen blockin sisalla na-

kyy luku, joka kertoo blockissa olevien pisteiden maaran. Pistemaara on hyva, kun nu-

mero on vihred.

Design Black Boundaries
{Giart fram.  Shapes bmady crawn

Shyps level:

Lt bl
Leadod gvery: |50 Ik port,
[drimum coure: | 10 milion poirta
Magmum court: | 40 milon poirts

Good court: N 2 -
bedcourt: M3~

] -,
'_.+' i
=1 28
e ~;
- 001

5] =
Leen »
-
" Define Project

+

=1

-

<00,
s

tukset.

Kun halutut blockit on piirretty, maantetaan projekti.

Define new project -> File -> New project.

Praject information

dcanner | Mobile =
Dpscrpion  Femarrivartacel
el ot il
Sovage | | LAS 12 i
[ Fegure fie lockng

Detarm  Proect e dreciony ™
| Lnad class bat utomarcaly
[ Losaed e cokors automaticaly
[ Load rgecio=es auomatcaly
Dinectory
[ Relerence poject exisls
Proyect fie

Defat 1000 m Slock sze
Blewck prefoe: £t
Beck ramng:  Mumoer -

Kaytetdan  kuvan
Hrame .

aina;
o Scanner: Mobile
e Storage: Las 1.2
Carcel

Design Block Boundaries -tydkalun ase-

asetuksia.

Description projektin mukaan ja

STARA

Pldetidn Stadista huolta.
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Maarityksen jalkeen projekti tallennetaan.

Tamaén jalkeen blockit maalataan
Jja valitaan Block -» Add by boun-

daries.
Add blocks by boundanes
File prefa
Hunbwding | Sebection order s
First rumber
oK Cancel

Kun blockit on muodostettu, pisteet tuodaan projektiin.

STARA

Pidetddn Stadista huolta
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TP gramty s prep

Consrib dom aret Vvl

L5 ]
. IS0 Oefre
foma LAS12 -
Tredom Hore -

rput e GFS secondualweek = 435788

FAghtine numbenrg.
bnerumtes  Use fom fle -
Icarner rumberyg
Scarerumtes  Usefom e =
Sk

Pistepilveen taytyy viela tehda koordinaatti korjaus.

5(34)

Pisteiden fuonnissa kaytetdan naita asetuksia.

Blockijako on tehty siten ettd harvennusta el enda

tarvitse tehda.

Pistepilvesta valitaan aluksi vahintaan nelja selkeda pistettd, joiden koordinaatit kaydaan

mittaamassa takymetnilla maastossa.

Pisteita tulee olla ainakin mittausalusen

molemmissa paissad siten, ettd mittausgeometria on hyva. Pisteet on hyva wvalita

maaliviivasta, tai muusta pinnasta jossa on pistepilvessa korkea intensitestti.

TerraScanin paéaikkunasta valitaan identify, jonka jélkeen haluttua pistetta kiikataan

pistepilvessa.
=
e Qupuw FPort Mew Comfy Tools Bghtine
25458002 Z30 BETE550.248 +7.827
25458000 210 BETEE5].252 +7.840
25458002 206 B5TE550.263 +7.832
25458000 A2 BETESS0.2T +7827
Show locaton [hantefy

Kun haluttua pistetta on painettu
pistepilvessa, se nakyy korostet-

tuna TerraScanin paaikkunassa.

Valittujen pisteiden koordinaatit poimitaan listasta tekstitiedostoon. Tiedostoja tarvitaan
kaksi, toinen X- ja Y-konaukselle eli tasokoordinaateille ja toinen Z-korjaukselle eli ko-

rolle.

Liite 1
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Maastossa mitattuja koordinaatteja verrataan pistepilven koordinaatteihin ja korjaustie-
dostoihin tehdadan tarvittavat erotukset.

Tiedoste Muokkaa Muotoile MNayta Ohje

r25498831.239 6675294.138 @.015 ©.015 ©0.000
25498887.638 ©675533.781 09.003 0.024 0.000
25498261.0824 6676195.588 -0.816 0.011 ©.000
25497983.024 6676232.760 0.006 ©.018 0.000
254980082.176 6676550.245 0.009 0.008 0.000

Tiedoste Muokkaa Muotoile MNaytda Ohje

25498831.280 6675294_.138 ©.000 9.000 -9.826
25498887.638 6675533.781 ©0.000 9.000 -9.914
25498261.824 6676195.588 ©.000 ©.000 -0.018
25497983.0824 6676232.760 ©.000 0.000 -0.918
25498002.176 6676550.245 ©.000 9.000 -0.007

B Project: herman...  — X
Fe Block \View  Tools
L I Bn Korjaus tiedostot tuodaan projekti-ikkunasta.
pt 000001 las Adjust to geoid
pt000002 Jas
000003 Jas | Adust xyz. o . .
Convert storage format TerraScanin tydkaluikkuna -> Define Project -
Quiput control report =
Shaw statistics Projekti-ikkunasta Tools -» Adjust xyz.
Check coverage
Show location Yphdate blocks 3 5 2z s
R Ensin korjataan xy-koordinaatit ja sen jalkeen
z-koordinaatit, korjaukset on tehtava tassa jar-
color from images
Extract echo properties jestyksessa tai ne eivat toimi.
Export lattice models

Expor raster mages

STARA

Plirtddn Stadista hualta.
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3 Luokittelu ja macrot
Macroilla pistepilven pisteet jaotellaan luokkiin, jotka helpottavat pistepilven kasittelya.
Kaikki pisteet luokitellaan aluksi Default-tasolle. Muita luokkia ovat mm. maanpinta, kas-

villisuus ja roskat.

Luokittelun voi tehda yhdelle tai useammalle blockille kerrallaan. Nopein tapa on ajaa

macrot jokaiselle projektin blockille samanaikaisesti.

Macro-ikkuna aukeaa TerraScanin paaik-

kunasta Tools -> Macro.

Macro-ikkunassa File -> Open -> Valitaan

oikea macro -» Run -> Run on selected fi-
B Processing (Nt Responding) ~ — -

les.

an

Add -> Maalataan blockeihin jaetut pistepilvet -> Kaytetdan kuvan asetuksia.

Run macro on files

Fies to process

“wille \hermanninrant atie 3'pt 000001 Jas *
ville \hermanninrant atie 3'pt 000002 |as
ville hemmanninrant atie 3ot 000003 las
ville hemanninrant atie 3\pt 000004 las
ville \hermanninrant atie 3\pt 000005 las Re
ville \hermanninrant atie 3'pt 000006 las v

noOnNnonmn

Fit view: Mone ~
[] Update all views after loading

Input format: | Automatic recognion
WGSE4: | Do not apply X

Transform: | None v
Save As; LAS 12 -
(] Dwectory Onginal Prowse

[] Bie name Original
[ Etension LAS

OK Cancsl
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Macrot pystyy ajamaan myds auki olevalle blockille.

TerraScan - 0 points

File | Qutput Point  Miew
[ Qpen block | Avataan haluttu block TerraScanin paaikkunasta.

Bead points File -> Open block -> Osoitetaan haluttua blockia.
Read directory

Avatun blockin pistepilvi nakyy valkoisena, koska luokittelua ei ole viela tehty.

Macro -ikkuna aukeaa TerraScanin paa-

Ikkunasta Tools - Macro.

Macro -ikkunassa File -> Open -> Vali-

taan oikea macro -» Run -> Run on loa-
sing (Mot Responding)  — .
“ ded points.

Evecuting macro..

FnScanClamslybard{™1" 2.0 000 20.00.5.0.0.90.4 0.0

|

B Froces

STARA

Pidetddn Stadista huolta.
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Lopuksi siivotaan Ground-luokan pisteet koko pistepilviaineistosta.

Ground —luokan pisteet siivotaan blocki kerrallaan. Siivous on parasta tehda ennen vek-
toroinnin aloittamista.

[ TerraScan - 0 points

|Be | Quot Pont Vew
block .

Open inside fence

Bead points...
Read directory...

Save points

File => Open block -> Valitaan avattava blocki kursorilla.

Save points As

Close points

Kun blocki on ladattu, asetetaan Display mode -ikkunasta nakymaan haluttu luokka
(tdssd tapauksessa Ground). Lisaksi valitaan color by: shading, jonka avulla nakee pis-
teet, jotka tulee siirtaa Roskat-luokkaan. Tallaiset pisteet nakyvat pinnan epamuodostu-

mina.

O Medum vegetation

O High vegetaton

O Building

D L picarit

O Madel keypornts w

Liite 1
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Pisteet siivotaan Draw Vertical Section -tyokalulla. Pistepilvesta valitaan ohut suikale,

jonka jdlkeen painetaan kakkosnakymaa.

Nakymapainikkeet 1aytyvat Microstationin vasemmasta alakulmasta.

Nakymapainikkeet

e [F)2]3lels]s]7]e]

Display m.. e x
Vew 2
Color by | Oass: Coiors.

(.
Weight: | ——

Lines | Craw al

Dims: | Draw al Asetetaan Display view mode -ikkunasta view 2 vain

Speed | Nomal - all ponts g T 2ot 2
[] Use depth Ground-luokka nakyviin ja kaikkien pisteiden piirto

-

. padlle. Pisteet nakyvat paremmin muuttamalla Weight -

Ground

e asetuksesta viivan paksuutta.
SAUM eQetahon

High vegetabon

Busiding

Low port

Moded keyports

Foakat »

A Qn

-
!
0Oo000o0oooe

Aecly Nvewwn B 7D

STARA
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Pisteet siirretaan Roskat-tasolle rajauksen mukaan.

Kaikki pisteet ndkyviin -> Plirretadn aifa monikulmiolla haluttujen
pisteiden ympérille -» Classify by fence —tydkalu ja alla olevat

G

Classify Fence

9 - Roskat

From class: |}-\ny visible paint

*
MREE
w!| [e>

Mikali Roskat-luokkaa el vield ole niin sen voi luoda Display mode -ikkunasta. TerraScan

péaéikkuna -> View -» Display maode -> Colours -> Add.

Wiew
Color by

Weight
Lines
Dims
Speed

Class

Ft

Colors

Draw al

Draw al

Fast - spare poirts
[ Use degth

Al Qn

Invest

Al Off

Apoly

DpopEEREE

E Class 0 Lo

Default

Ground

Low vegetation

Medwum vegetaton

High vegstation

Building

Low paint w

Al views )

File
Code Description
1 Defaul
2 Ground
3 Low vegetation
i

Medium vegetation

5  High vegetation

€& Bulding

7 Low point
Model keypoints

Draw Ld Calor »

Mot aet 1 0 Add
Net set 2 6

Not set 3 14

MNotsst 4 50 Edit
Not set 5 2

Mot set 6 3

Notsst 7 5 Deiete
Mot set B 43 ~

Paint class

Number
Code
Descrption

Draw as
Color
Weight

Element

Level]

9
Floskat
Not set

M5

Zem length ine ~

]

-

Cancel

STARA
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Kuvassa pisteita, jotka ovat selvasti maanpinnan
alapuolella ja tulee siirtaa Roskat-tasolle. Siirret-
tavia pisteitd voi olla myds maapinnan yldpuo-
lella, esim. rakenteiden katot.

Leikkausta voi siitdd Move selection -tydkalulla. Leikkaus siirtyy
eteen ja taakse hiren vasemmalla ja oikealla painikkeella. Koko

blocki kaydaan lapi.

Jos luckittelussa tapahtuu virhe,
tehdyn komennon voi perua Ter-

rasScanin padikkunasta.

Point -> Undo Classify Fence.

STARA

Pidetddn Stadista huolta
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) Classify Fence

From dlasa:  Any visible point

13 (34)

Toinen tapa korjata virhe on laittaa Display mode-
ikkunasta Roskat-luokka nakyviin. Classify Fence -

tyokalun asetuksia muuttamalla pisteet voi siirtaa

Lite 1
16 (37)

} Assign Point C...

takaisin Ground-luokkaan.

Valilla on hyva tarkistaa Ground-luokan
pisteet ykkosnakymasta, jossa virheelliset
pisteet nakyvat hyvin Shading-asetuksen
ollessa paalla. Assign Point Class —tycka-

= From] 2 - Ground e P g e T
-~ Oty (R - lulla voi siirtaa yksittaisia virheellisia pis-

: Select: Closest e teitd ylanakymasta.
té,. G[I. Within: | 1.00 m
L;; To cass: 9 - Roska -

Classify | Tools Flightline Ground-luokan pisteitd siivotessa siirre-
jL__Boutine | Byclass taan samalla nolla intensiteetti pistest
] *| Arpaints E Roskat-tasolle. Tama tapahtuu TerraS-
{ Chny pulr i [ canin paaikkunasta ja tehdaan jokaisen
§ Isolated poirts ( .
| Low points blockin kohdalla.

Trajectory interval Ground - -

Detect plane Hard S Classify by intensity

Detect trees Below gurface From class: |Any class -
PR By height from ground To class: |9 - Roskal v
Add point to ground By gbsolute elevation Foseiy] (Pt beek 5

T By echo Intersity: | 0 1
By echo difference () foido femce orly
L3 -' Gl
|_ By intensity
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Pisteet tulee tallentaa, kun blockin luokittelu on saatu valmiiksi ja blockia ollaan sulke-

massa.

B pt000032.12s - 19071 416 points - x
|ble | Quiput Point \jew Qessfy ook Pightine

4 Viivamaiset kohteet

Vektoroitaessa tulee miettid, miten sama alue kartoitettaisiin takymetrilla. Lisaksi vekto-
roidut kohteet kannattaa aina tarkistaa jalkikateen en kuvakulmista. Kuvakulman kaan-
taminen onnistuu painamalla shift-nappain pohjaan, jonka jalkeen hiiren keskinappainta
klikataan pistepilvessa. Nyt ndkyma pyoni hiirta likutettaessa painamasi kohdan ympa-

rilla.

Pistepilven selkea tulkitseminen on tarkeda vektoroidessa. Display mode -ikkunasta loy-
tyy erilaisia tydkaluja visualisoinnin ja tulkitsemisen helpottamiseksi. Alapuolella esitet-
tyna sama kohta pistepilvesta. Vasemmanpuoleisessa kuvassa varityksena on luokat ja

oikeanpuoleisessa kuvassa pisteiden intensitestti.

Metropolia
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Vektorointi kannattaa tehda loogisessa jarjestyksessa. Top viewista on helppoa piirtaa
maaliviivat ja tien reunat. Aloitetaan valitsemalla TerraScanin tySkaluikkunasta Mouse
Point Adjustment -tydkalu. Mouse point adjustment -tydkalun ollessa paalla, tartunta
tapahtuu pistepilveen. TAman jalkeen voidaan piirtad Microstationin piirtotydkaluilla. Jos
haluat etta piirtotyokalu tarttuu myds piirrettyihin elementteihin, poista valinnat kohdista

Adjust elevation ja Adjust xy. Valinnat tulee lisata takaisin tartuttaessa pistepilveen.

BMDUSE... — *
d [ Adust dlevation Dz 0.00
EA Adiust xy
Jass: Any class -
Poini: |Closest >

Within: | 5.00 m

Lines: Draw al . . ; .
Dms: Drawal Vektoroitaessa on hyva muistaa etta vaikka pisteet on
Spoed [F]“U:;;_‘m pilotettu  Display mode -ikkunasta, niihin on silti

B — mahdollista tarttua Mouse point adjustment -tyokalulla.
Agn | O Defaur e

B Gound
B Low wegetlation
et O Medium vegetation
O Hgh vegetation
E Buiiding
Low point
Anog O Model keypoints w

Aooly Hvens v P
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Mouse Point Adjustment -tykalua kaytettaessa voidaan valita luokka, johon kursori tart-
tuu. Yleensa tien reunoja, maaliviivoja Ja muita maassa olevia kohteita piirrettaessa kan-
nattaa tarttua joko Ground- tai Low vegetation-luokkaan. Joskus tama ei kuitenkaan ole

mahdollista.

Asettamalla varityksen luokkien
mukaan, nakee mita tartuntaa
Mouse Point Adjustment —
tydkalulla kannattaa kayttaa.

Kuvan kanttikiveyksen pisteet
ovat lahella olevan puuston takia
luokittuneet Medium vegetation -
luokkaan, joten tartunta tulee

valita sen mukaan.

Kanttikivetyksen havaitseminen
ylandkymastd on mahdotonta puun

latvuston takia.

Lite 1
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Pillottamalla High vegeta-
tion —luokan, kanttikiven

nakee paremmin.

Ylia olevassa kuvassa katoksen havaitsemiseksi pistepilvesta myos High vegetation - ja
Roskat-luokkien tulee olla paalla. Suurin osa katoksen alla olevasta pistepilvesta on Ros-
kat-luokassa, joten tarttuminen Ground-luokkaan, jossa ei ole tarpeeksi pisteita ei on-
nistu. On mahdollista kayttaa Low vegetation -luokkaa, jonka pisteita 16ytyi katoksen alta
tarpeeksi. Roskat -luokkaan tarttumista kannattaa valttaa, jos muiden luokkien pisteita

on riittavasti.
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41 Kanttikivet

Kanttikivetyksen vektorointi on vilvamaisista kohteista eniten aikaa vieva. Kanttikivetyk-

sen vektorointi kannattaa aloittaa alareunasta. Nain riski vektoreiden ristiin menosta on

pienempi.

Kanttikiven reuncjen loytaminen vaatii
nakyman kadntelyd. Nakymaa voidaan
kddntdaa painamalla Shift-nappainta
pohjassa ja samanaikaisesti klikkaa-
malla hiiren keskirullaa pistepilvessa.
Taman voi myods tehda Kaanna naky-

maa —tydkalulla.

Liite 1
21 (37)

STARA

Pidetddn Stadista huolta

s

70

Metropolia



Liite 1
22 (37)

19 (34)

411 TerraScanin tyokalu kanttikiven havainnoimiseen

TerraScanista l6ytyy tydkalu kanttikiven havainnoimiseen. Tydkalu ei ole pakollinen, eika

aina valttamatta nopeuta vektorointia, mutta se saattaa olla paikoittain hyodyllinen.

Piirretaan Smartline, joka kulkee kanttikiven mukaisesti -> Avataan TerraScanin tycka-

luikkunasta Find Curb Along Element -tygkalu -» Valitaan asetukset (oikeiden luckiien

valitseminen vaikuttaa ratkaisevasti lopputulokseen) -> Osoitetaan piirrettya Smartlinea.

Tyokalun kaytdn jalkeen voidaan kanttikiven
reunat piirtda syntyneita elementteja apuna
kayttaen.

Syntyneet elementit tulee poistaa tydsta jossain vaiheessa. Koska elementit ovat oletus
tasolla, helpointa tama on tehda kayttamalla tasojen nayttda sen jalkeen, kun vektorit on
muutettu kartoituskohteiksi Terra Surveylla.
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5 Pistemiiset kohteet

Pistemaiset kohteet ovat yleensa valaisinpylvaita ja puita. Alla olevan kuvan pistepil-
vessa on pul ja valaisinpylvas. Valaisimen tyvea tai puun runkoa on kuitenkin mahdoton

nahda ylanakymasta.

Kytkemalla High vegetation -luokan nayttaminen pois paalta, valaisimen jalka ja puun
runko ovat helppo havaita. Saatamalla tarttuminen vain Ground- tai Low vegetation -
luckkaan, ei vahingossa tule tartuttua puun latvuston pisteisiin. Tama on vaarana, koska
vaikka High vegetation -luckan nayttdminen on pois paalta, sihen voi silfi tarttua.

Lite 1
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Ensin piirretaan viiva, joka lapaisee koh-
teen ja jonka alku ja loppupiste ovat maan
tasossa. Tarftuminen maanpintaan ta-
pahtuu Mouse Point Adjustment -tyoka-
lulla. Viivat piirretaan kaikkien pistemais-

ten kohteiden l&pi.

Taman jalkeen voidaan piirtad Smartline, joka kulkee kaikkien puiden kohdalle piirretty-
jen vivojen kautta. Viiva tulee piirtda siten, etta se kulkee kartoittavien kohteiden keski-
pisteen lapi. Tama onnistuu Lahipiste-tartunnalla. Jos valaisinpylvaita on blockissa vain
yksi, Smartlinen toisella paalla ei ole valid. Muista kuitenkin poistaa ylimaarainen sym-
boli, joka syntyy, koska Draw as Feature —tydkalua kaytettdessa pistemdainen symboli
tulee Smartlinen molempiin paihin.

& X [a]

—

Lahipiste-tartunta}

Kayttamalla TerraSurveyn Draw As Feature -tydkalua saadaan nyt kaikki puut vektoroi-

tua kerralla. Sama prosessi toistetaan valaisinpylvaille ja muille pistemaisille kohteille.

'_, Draw As Festure — x
Koodi] | €
Koodi: (30 Pytvas -
Numero: | 13
Mitta: | 300 mm
Irfo
) Lwe kopio

Myds vilvamaiset kohteet muutetaan Draw As Feature -tydkalulla kartoituskohteiksi.

Lopuksi poistetaan kaikki apuviivat. Helpoiten tama onnistuu pillottamalla kaikki muut
paitsi oletustaso ja sulkemalla pistepilvi.
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6 Pintamallin teko
Takymetnilla tehtavassa kartoituksessa pintamallin tekemiseen kaytetaan kartoituskoh-
teiden lisaksi maanpinnan hajapisteita. Laserkeilausaineistossa kaytetdan kartoituskoh-
teiden lisaksi hajapisteiden sijasta maanpinnasta luokiteltuja avainpisteita
6.1 Model keypoints
Model keypointsit ovat maanpinnan pisteitd, jotka ovat pintamallin kannalta oleellisissa
paikoissa. Jos Ground-luokan pisteitd el ole vield siivottu, niin se tulee tehda ennen Mo-
del keypointsien luomista.
Tarvitset macroa Model keypointsien luontiin.
TerraScanin pééikkunasta Tools -» Macro —=> File -» Open => Mode! keypoints -> Toi-
sesta macron askeleesta valitaan tiedosto, johon Model keypointsit kirjoitetaan.
[r—— =
dgtien. Cutout parts - e B
Bits Mperts B arrten Vadmbrroty  Erocen hghtioes sepacaisly Ty
2 :'I l":au-m : " bae TS Frocess wcannen sepaelely Slave conn

[ e e el

Dte ot ramrrerees ery mosminneee
Forer: [LAS 12 - e

i Mg e cxinl

From class: 2 - Ground » -+
Toclass: § - Model keypoinis -
] ipside fence oy
Lse pornts every. 200 m
Tolerance ghove: 050 m
Tolerance elow. 050 m

- ==

Sitten Run -> Run on selected files -> Valitaan aiemmin luotu siivottu Ground-luokan

pistepilvi -> Nama asetukset.
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Run macro on files
Hes to process
- wille \hermanninrant atie \terra \pt 000033 las Add_
e wille \hemanninrantatie \tema \pt 000034 Ia=
¢ \wille \hermanninrant atie \tera \pt 000035 las
Remove
Fit view: | None
[ Update all views after loading
Huom! Save as: Do
Iput format: | Asomatic recogniion ¥ not save all points.
WG584: | Do not apply -
Transform: | None v
iSave As| Donotsave alponts ~
t Original Browse
Cancel

Taman jalkeen pisteet voidaan sulkea TemraScanin pasikkunasta File -> Close points.
Jja luodut Model keypointsit avataan. Read points -> Valitse Model keypoint -tiedosto.

Lopuksi lian lahella elementteja olevat Model keypointsit siiretaan Roskat-tasolle, jotta
niitd el ole esimerkiksi kanttikiven yla- ja alareunan valissa.

Aluksi turhat tasot laitetaan piiloon. Korkolukemat pillotetaan, mutta blockirajat jatetaan
nakyviin. Sitten maalataan kaikki elementit, joiden ymparilta pisteita karsitaan ja valitaan
Classify by centerline -tydkalu.

modelkeypointstesti - 4457 points = X

Be Ouiput Pot View  Cossiy Tocls Fghliine
| Boutine *|  Bydass EA

*  Brpoiris..

Anidn b Oloashy ponts. ha
3D fence.. lsolsted ponts a3
Low points. -
i e Tractory rterval Greund
Detect plane. Hard surface
Datect rees Below sudace

Aggn By height from ground
Add goirt to ground By ekt gevaton
By gcho

By echo diference
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Offset-asetusta voidaan muuttaa tilanteen mukaan, mutta luokkien tulee olla alla olevan
kuvan mukaiset. QOffset kannattaa olla aika pieni, esimerkiksi 0.3m. Toisessa kuvassa
nakyy violetttina Roskat-tasolle siiiyneita Model keypointseja jotka olivat
kanttikivetyksen sisalla.

Classify by centerline

From class: 8 - Model keypoints - o
Toclass: 9-Roskat -
Use: Selected inear elemenis ¥

Compare with: Any line X
Side:  On either side v

Offset:  0.00

[] By elevation difference

[] By longitudinal distance from vertex

Carce

Pisteiden luokittelut tallenetaan TerraScanin paaikkunasta File -> Save points.
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6.2 Pintamallin teko Model keypointseista
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28 (37)

25 (34)

Pintamallin teko aloitetaan avaamalla aiemmin luodut Model keypointsit TerraScanin

pasikkunasta.

Taman jalkeen pinta kolmioidaan.

. modelkeypointstesti - 4 457 points
Fie [Output | Point View Classfy Tools _Flightine

9| — 6675821.002 42935 14810

8 :“ 6675828959 a071 2138

g| Expotliattice model... 6675836.925 326 21298

8| Expotrasterimage. . 6675814.316 42524 683
| Write to design file...

Sl Draw asline strings... Identify

Create surface model

{Point ciass [8 - Model keypoints ~|
[ Corce
Keolmioi pinta
] hniseie -

fidan sisako

Karsi ulioseunal.  Oletuskarsinta -

Paempi kun: | 500 m
B Mars labda pakca
Poampi kun: 500 m
[[] Harvenna laheiicaset pistest
Mremstanye: |0 m
[[] Morsta piseta tatevivaan
Vak: (500 m
[[] Suodata wenepistest
Firra tasolie: | 50
Pt
Pinnan tiedot
Yieistied
T Maa z
Talletus

Tiedosto: | her.ammomramtatoeblock 3107

—c— rese
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Nyt kolmiointiin otetaan mukaan myos vektoroidut kartoituselementit.

Aloitetaan piilottamalla turhat tasot kuten blockirajat ja korkeuslukemat.

Kun turhat elementit ovat pillossa, valitaan Kolmioi nakyma—tyckalu.

o Kolmioi nikyma

Kayraelementit -
B-spline elementit:
Mut lineaariset:
Pistemaiset elementit:

Tattevivoina
Tatevivoina
Tattevivoina
Tattevivoina
Hajapisteina

X

4

4

4
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Kolmioi pinta

Aidan sisalto

Karsi ulkoreunat: | Oletuskarsinta

Pitempi kuin: | 50.0 m
Karsi kaikki pitkat kolmiot
Pitempi kuin: | 50.0 m
[] Harvenna lahekkaiset pisteet
Minimietaisyys: | 0.1 m
[] Monista pisteita tatevivaan
Vali: | 50.0 m

[] Suodata vihepisteet
Piira tasolle: | 50

P

Malii1 =

Liite 1
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Pinnaksi valitaan aiemmin luotu pinta.

Kun pintamalli on luoto, kolmicinnin saa esille Esita kolmiot —tydkalulla. Valitse pinnaksi

ailemmin luomasi pinta.

Esitd kolmiot

Pitotapa:
Taso: | 59

[ Varitaytto

Vain aidan sisalta

Piirra vartystaulukko

.
-

Varays:  Korkeustason mukaan

[] Vakictasoon Korkeustaso
[[] Pehmenna reunat varjostukseen

S | s—

STARA

Pldetidn Stadista huolta.

Metropolia



Liite 1
31 (37)

28 (34)
Varjostuksen avulla kolmioinnin tarkastelu on helpompaa.
T Esitd varjostus
Frta} Maki1 2
% @‘ Aumngon suunta: 450
“Foita Auringon kulma: 250 astetia vaskatasosta TerraModeler péaaikkuna ->
EE N e T I——— E518 varostus
|
_’;l Naymaz 4102 (204 Mon
B 05080208 ng

e =2 i

W Taman jalkeen voidaan tarkastella kolmiointia ja siivota
Karsi kalmic

ﬂ@’

pois kolmioita ja pisteita, jotka ovat selvasti virheellisia ja

} huonontavat pintamallia.
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et " Reunojen pitkat kolmiot saa karsittua parhaiten maalaa-

Tps  Masdaten -

malla.
Brasukare 1l
Para karshut

Reunojen lisdksi kolmiointi poistetaan muun muassa kanttikivetysten sisalta. Tassakin
kohtaa kannattaa miettia miten kolmioinnin kanssa toimitaan takymetrimittauksen pinta-

mallinnuksessa.
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6.3 Korkeuskayrien piirtaminen
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Korkeuskayrat voidaan piirtaa, kun kolmiointi on valmis. Tydkalu Ioytyy Modelerin tydkalu

ikkunasta. Kayta alla olevia asetuksia.

Esita korkeuskayrat
Tiedosts  Asetukset

Finta; Mallil v
Ptotapa:  Kijoita kuvatiedostoon =
Pira: Kaymna -
[ foukayrat vai: | 0100 m
A Peruskayrat Vai: 0500 m
[ dotiokaya Vai: 1000 | m
[] Viettovivat
Pennia

Korkeuskayrat tarkistetaan ja jos ne eivat ndyta fiksulta, esitys pyyhitaan ja

kolmiocinti tarkastetaan uudelleen. Pyyhi esitys —tydkalulla voi myds poistaa kolmioinnin

ja varjostuksen, jotta kayrat nakyvat paremmin.

Pyyhi esitys
i @_ Pirta? [Mali1
S s
LB Kayrat:  Kijotettu

Pyyhi layrat
Pryhi koimiot
Pyyhi dstilkcko
Pyyhi bukemat
Pyyhi katevuiudet
Pyyhi rasteni

Pyyhi vanostus
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Kayriin voi tehda pientd editointia Poista piste -tydkalulla. Pisteiden
poiston jalkeen nakyma paivittyy painamalla Paivita esitykset—paini-
ketta.
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6.4 Pintamallin teko Model keypointseista tapa 2

Pintamallin teko aloitetaan avaamalla aiemmin luodut Model keypointsit TerraScanin

padikkunasta.

Ylimaaraiset tasot on piilo-
tettu ja Model keypointsit
avattu.

Kun pisteet on avattu ja korkeuslukemat, blockirajat ja muut
elementit, joita el haluta pintamallin on suljettu, valitaan

TerraModelensta Kolmiol useista lahteista —tydkalu.
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Uusi pintamalll nimetaan ja lisatdan valinnat Karttaelementit ja TerraScanin ladatut la-
serpisteet kohdalle. Model keypointsien luokka on yleensa 8, mutta tarvittaessa sen voi

tarkistaa Display view mode —ikkunasta.

Kolmioi userta lahtests

Pirtamalli
Lwo:  Normasi mali
Tyvooi: Maa o
Bimi: Maanginta
Tiedosto: = maarpintatin

4

Shanndt: | Selaa
bl Karttasiemertt
A TemaScanin ladatut leserpistest
Luokat:
(] Tee tasta Editable model
[ Aa esikasiteymakro Selaa.
Makrg
[] Laserpistect binaartiedostosta

Selaa
o] Fenata

Kun pintamalli on luotu, kolmioinnin saa esille Esitd kolmiot —tydkalulla. Valitse pinnaksi

ailemmin luomasi pinta.

lod Esitd kolmiot
P
& zb ot
+ - Esik atselu -
T u_. Varjays: | Korkeustason mukaan -
SRS Taso: | 59
’N@» HE
= -
51 |'r:'1 [] Vartaytto
[ Vakiotasoon Korkeustaso ]
Aeh
@ [] Pehmenna reunat varostukseen

3 *
@ -* Vain aidan sisatta
»
. | C—

Piira varitystaulukko

(ol
B -
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Varjostuksen avulla kolmioinnin karsiminen on helpompaa.

Esita varjostus

Aunngon guunta; 450
Auringon gima: | 250 | astefta vaskalasosta Terralodeler péaéikkuna ->

Vartys: Olefuzvarit =

Voiopias: 1| I sy ESt@ varjostus

Makymat

W Taman jalkeen voidaan tarkastella kolmiointia ja siivota
Karsi kalmic

ﬂ@’

pois kolmioita ja pisteita, jotka ovat selvasti virheellisia ja

} huonontavat pintamallia.
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